
“We realized that the important thing was not the film itself but that which the film provoked.”

—Fernando Solanas ("Cinema as Gun")

“Every cut is a lie. It's never that way. Those two shots were never next to each other in time 
that way. But you're telling a lie in order to tell the truth.”

—Wolf Koenig

With Final Cut Pro you can produce sophisticated multimedia –
combining audio, images, video and graphics. 

FINAL CUT PRO (FCP for short) is a non-linear video editor. 
You can edit your video in any order you want, and access the beginning, middle and end of your 

video simply and quickly.

It is also non-destructive. This means you can cut, delete, move, change and adjust your video 
and audio happy in the knowledge you haven’t destroyed anything.

*This is designed as a get-started tutorial NOT a  complete Everything You Always Wanted To 

Know About Final Cut Pro And Were Afraid To Ask tutorial.

IT is specifically written for Final Cut Pro 7

There are many resources available for learning more about Final Cut

F I N A L  C U T  P R O
An introduction to  Video Edit ing

http://www.apple.com
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GET READY
Setting up yourself and FCP 

Before you even open the program though, it’s extremely important to get 
organized.  FCP is complicated.  Video is complicated. There are many files and 

folders and it is very easy to ‘lose’ stuff.

Get Organized. Stay Organized.
	
you will thank me later.

Create a Project Folder for every, er, project.
	
	
 This folder will hold everything associated with your project. Here is a 
sample system - the exact naming convention is less important than being consis-
tent and logical: 

Some folders will hold the content you create:
Audio, stills, video files, graphics will go into their appropriate folders.
FCP generates render and cache files, sequences, etc and we will ‘direct’ FCP to 
place files in these folders.

DO THIS. And your project will exist in a single place. You can copy it to an-
other drive, give it to another person to edit.

DON’T DO THIS and files will get lost.  projects won’t work, your harddrive will 
fill up and you will go crazy.

 

NOW, open the Final Cut Pro application.
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TIP
•

Many of the terms we use 

in video editing come from 

the days of film and razor 

blades and linear, ‘do it by 

hand’ editing.

•



You may get this warning screen:

        

By default, FCP looks to see if a video camera is connected. 
Click ‘Continue’ unless you want a camera connected at this point and it isn’t. 

1. Save your Project:  name it the same as your Project folder : 
Date_YourName_ProjectName
Save it into the _FCPsequences folder inside your Project Folder

2.  In FCP, go to Final Cut Pro/Systems Settings: (this is where you’ll tell FCP 
where to save all the files it creates.

3. Set the paths for the render and cache files to the RenderAndCache 
folder you created:
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TIP
•

Many of the terms we use 

in video editing come from 

the days of film and razor 

blades and linear, ‘do it by 

hand’ editing.

•

TIP
•

IF you are using a tape 

camera, connect it to your 

computer and turn it on 

before starting Final Cut 

Pro

•



	
Click the four ‘Set’ buttons and direct EACH to the project’s RenderAndCache 
File.

	
NOTE:  You must do this each time you open a project, especially on a new 
or shared computer.  Without these files you may not be able to re-open a pro-
ject.

Click OK

FCP will continue, and your screen should look like this:
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TIP
•

IF you don’t set up your 

project folder properly, im-

portant files will be stored 

in the wrong place. On the 

school computers these 

files will be deleted over-

night and you will be very 

sad.

•



GETTING VIDEO INTO FCP

First, we need to tell FCP what kind of video we will be using.
The exact settings will vary depending on which camera you were using

Go to: Final Cut Pro/Easy Setup

You will see this dialogue box:
We typically will shoot HD so set the format to HD
For most of the cameras we use, 1080i60 is the appropriate setting (but double 
check in class - the Nikon D90 is one exception)

Click ‘Setup’

What happens next depends on what type of camera you are 	

	
 	
        using:

1. Tape Cameras
2. Hard drive or card based devices
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Tape Cameras
The camera must be plugged in and turned on before opening Final Cut.
Rewind your camera to the start of the video you wish to ingest

	
 	
 	
 Go File>Log and Capture

With some cameras, FCP will automatically begin to play the tape and ‘capture’ it. 
Sit back, relax, wait. 
With some cameras you’ll get this window and have the option of naming your 
files. Then click the ‘Now’ button, sit back, relax, wait

When FCP is done, save your project, turn off the camera and disconnect it. It’s 
important to disconnect the camera so you don’t confuse FCP.

Hard Drive cameras

If your camera records to a solid state drive or SD card:

Use a card reader to copy the digital files to the ‘video’ folder in your project 
folder.  The exact workflow will depend on which camera you are using.

For some cameras use the Log and Transfer function in FCP.
Some camera files can be imported directly in FCP by going flie/import

Check in class for which method to use
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TIP
•

Ingesting tape is a real-

time experience.. Shoot 30 

minutes, wait 30 minutes 

to ingest. Make sure you 

plan accordingly

•

TIP
•

IF your camera uses a card, 

make sure to copy the 

whole file structure into 

your ‘video’ folder - not just 

the movie files. FCP needs 

the various folders to prop-

erly recognize the video

•



EDITING
phew….all that work and we haven’t even begun to edit video!

At this point you should have a project window that looks something like this:
The standard arrangement of windows

There are four panels and a variety of controls and tools. Here are some basics:

1. Browser - it shows all the media (video, stills, etc.) that you have imported 
into your project. It’s the file cabinet.

2. Viewer - from here you look at what is in your Browser. Double click on a 
video clip in the browser and it will appear in the Viewer window. From here you 
can play the clip and set in and out points and drag it to the Timeline.  You can also 
view what is on the Timeline here - to edit, color correct, etc. Double click on 
video on the timeline and it will show here AND in the canvas.

3. Canvas - This window shows what is on the timeline. as you play the movie 
on the timeline it will play in this window.

4. Timeline - this is where you edit and build your movie. By placing clips and 
then cutting them up and rearranging them into a compelling story.
You can have multiple video and audio tracks and create very complex effects.

5.Tools - you can access tools from the tool bar or thru keyboard shortcuts . 
Roll over a tool to see its name and quickkey.  To start, rely on the Selection 
tool (a), the top arrow, for selecting and dragging around clips and the Blade 
tool (b) for cutting up clips into pieces.
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TIP
•

IF you rearrange your win-

dows and want to return to 

this standard view go to 

Window>Arrange>Stan-

dard or ‘control U’ on the 

keyboard

•

TIP
•

You can import all sorts of 

media into FCP – still pho-

tos, audio, graphics. FCP 

prefers uncompressed me-

dia so save your photos as 

tiffs and your audio as an 

aif or wav file for best re-

sults.

•



Here’s an example of a relatively simple project:

The timeline contains multiple tracks of audio and video.  Note the scrubber in 
the timeline. It is the thin grey vertical line with the yellow triangle tab.

The scrubber shows the current play position for the video. So wherever the 
scrubber is on the timeline, shows in the Canvas window, top right.  You can drag 
the scrubber by clicking in the grey bar where the yellow tab is. You CAN NOT 
grab the scrubber in the middle.

Typically, you’ll look at video clips from your Browser in the Viewer and decide 
which parts you want to use.

So, for example, you would double click on a video clip in the browser, and it would 
appear in the viewer window.  You can click play or use the keyboard shortcuts 
j,k,&l to play the clip.

Set ‘In’ and ‘Out’ points to select a portion of this clip and then simply drag that 
portion onto your timeline.
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TIP
•

To control the scrubber 

and play your timeline:

The space bar will stop 

and start the movie.

The keys J, K, & L will re-

wind, stop and start the 

movie, in that order.

Double clicking the J or L 

keys will speed up the 

play, either forward or in 

reverse.

•

The more keyboard short-

cuts you learn, the faster 

editing video becomes.

•



For Example:

Setting “In” and “Out” Points 

In and out points set the starting and stopping points in an edit.  Most of the time 
you’ll be setting “In” and “Out” points in the Viewer window. 

Set an ‘In’ point by using the letter ‘I’ key.  Use ‘O’ to set the ‘Out’ point.  Play the 
video in the Viewer and click ‘I’ at the start of a portion of video you are interested 
in using.  Clicking  ‘I’ again will reset the ‘In’ point.  Click ‘O’ to set the end of that 
clip.
Perhaps you need the first three seconds of a video clip. Set those In and Out 
points, drag that three-second clip to the timeline. Return to the Viewer and per-
haps grab another four seconds from the middle of that clip by setting new In and 
Out points.
As you edit your video your timeline will accumulate a selection of clips that you 
can move and rearrange by using the select tool. Simply click on a clip on the time-
line to highlight it - click delete to remove it, click and drag to move it on the time-
line.

Editing a video clip

Once a video clip is on the timeline, you can still edit it:
1.Move it using the selection tool. Click and drag. 
2.Cut it using the blade tool. Place the blade tool wherever you like, and click to 
splice that clip into two pieces.
3.Shorten or lengthen a clip by using the selection tool. Click on the end of a 
clip and drag it to shorten or lengthen it. 

NOTE that, for example, you can splice a clip, delete one piece, and then restore 
your cut by simply dragging out the length of the shortened clip.

Understand the notion that shortening a clip by dragging in one end is exactly 
the same as cutting a clip and deleting one piece. And both can be undone easily.
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TIP
•

common keyboard
shortcuts:

I – In point
O – Out Point 
J- plays clip backwards
K – Stops playback
L –plays clip forward
B –  Blade tool
A – Selection tool
N – Snapping

⌘ Z – Undo

⌘ S – Save
Space Bar – Play / Pause

⌘ 8 – Capture
Ctrl G – Closes gap in 
Timeline
Left and Right Arrow 
Keys – Move backward 
and forward one frame
Ctrl U – Returns the 
windows to the standard 
setting

•

The arrows show the ‘in’ and ‘out’ points set on a clip in the Viewer. As 
you click and drag the clip down to the timeline notice the arrow cir-
cled in red. 

As you drag the clip to the timeline you can either overlay it on top of 
other clips. or insert it, splitting them apart.

If the arrow is down, as it is here, it will overlay. If you move the clip 
up a bit before releasing it, the arrow will become a horizontal arrow, 
which indicates it will insert itself, splitting the clip.  Try it – it’s easier 
to do, than to explain.



TRACKS

You can have as many tracks as you like.  By default FCP opens a timeline with one 
video and four audio tracks (two stereo tracks). 
To add a track:
Sequence>Insert tracks
OR
simply drag audio or video onto the timeline above or below an existing track. FCP 
will automatically create a new track for you.

AUDIO

Generally, you’ll want to see the audio waveforms. this can help you find good 
edit points and let you ‘see’ your sound.
TO display the waveform:
Click the small arrow at the bottom, left, of the timeline and select Show Audio 
Waveforms

TO adjust the audio levels, you need to display the “Clip Overlays” button. Turn 
this on, and then you can adjust the audio by raising or lowering the pink line dis-
played in the audio track.  
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You want your audio to be, most of the time, around -6 decibels, visible in the me-
ters on the right as you play the timeline. Never let your audio ‘peak out’ by hitting 
zero.  If your audio is too quiet, it will be hard to hear.
And if it is inconsistent, viewers will be driven crazy adjusting their volume levels.

Adjust the audio of individual clips by dragging up or down that pink line. 

FADE Audio
To fade audio in or out, use the Pen Tool, at the bottom of the toolbar, to set 
points,  on the pink clip overlay line. then drag those points down to create a gen-
tle fade in or out of your sound
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TIP
•

Cleaning up your audio - 

adjusting the levels of each 

clip - is part of the polish-

ing of a video.  One of the 

last steps you should do 

when editing is play your 

piece and just watch the 

audio levels.

•

TIP
•

You can fade video in the 

same way. Use the pen 

tool to set points on the 

black line at the top of the 

video track. OR go Ef-

fects>Video Transi-

tions>Dissolve>Fade In 

And Out Dissolve

•



TEXT and LOWER THIRDS

Final Cut has its own text tool. You can also create title slides in Photoshop and 
import them into Final Cut. Photoshop offers more controls over design.

Final Cut’s text tool is at the bottom of the Viewer window:

Lower Thirds is a specific text tool.  It refers to the common practice of identi-
fying someone by placing their name and title on the ‘lower third’ of the screen as 
they speak.

Click on Controls to enter text for line one and two.  You can set the font and size 
independently of each other. Typically we make Line 2 smaller than Line 1.
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Text is a more general tool that gives a single text box

Again, the Control tab will allow you to enter text.

Once you have your text written. Go back to the video tab and drag it on to your 
timeline.  Place it on its own track above your video.  Text is transparent, so your 
video will show through.
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TIP
•

IF you want to edit your 

text AFTER you have 

placed it on the timeline, 

you need to make sure 

you are editing the clip 

you’ve created.

Put the scrubber over your 

text so you see it in the 

Canvas. THEN double click 

so it also appears in the 

Viewer. Changes you make 

in the viewer should ap-

pear in the Canvas. 

An easy mistake is to try 

and edit the version in the 

Viewer after you’ve placed 

it on the Timeline. IF you 

don’t select the text on 

the timeline by double 

clicking, you’re not editing 

it.

•



RENDERING

IF the the thin grey line at the top of the timeline is any color other than grey, you 
may need to render.  Certain file types, slower computers, lots of effects, can re-
quire rendering.
Rendering is Final Cut’s way of processing the information so it can handle it easily 
and quickly and in real-time.
IF the line is green you’re probably still ok. But if the video playback is jerky or you 
get a ‘dropped frame’ warning, then render.
IF the line is orange or red you’ll probably need to render:

TO RENDER:  Sequence>Render All> Both

EXPORTING

When you are done editing, you need to export your video - creating a standalone 
movie file.

There are several ways to export, and MANY settings to adjust depending on your 
final needs.

To create a basic quicktime movie that you can use: 

File>Export>Quicktime Conversion:
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TIP
•

Rendering is just for look-

ing at your video while 

editing. FCP will re-render 

the whole project again 

automatically when you 

export. So no need to ren-

der if  everything is work-

ing.



Enter the name of your movie, and place it in the output folder in your project 
folder. 

Click options…
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TIP
•

By default FCP will export 

the whole timeline. You can 

set ‘In’ and ‘Out’ points to 

export part of a timeline.

ALWAYS double check 

there are no extra clips 

hidden down the timeline 

before exporting. 

~

Click on your timeline and 

use the Shift-Z shortcut 

to reveal your entire time-

line to make sure.

•



The exact settings will depend on what you want. Check with 
your instructor. But...if you shot HD….and as a starting point

1.Settings: 
i. Change ‘Compressor Settings’ to best. leave everything else the same

2. Filter:  
i. don’t touch

3. Size: 
i. set to 1920x1080 for full HD IF your camera shoots this resolution. (The 

Nikon D90’s only shoot 1280x720)
ii. Check Deinterlace video for most cameras (Leave unchecked for DSLR 

cameras such as the D90)
4.Sound:
 	
   i.   Make sure ‘Sound’ is checked
    ii   Change Render settings to Best

Click OK, then Save, then sit back and wait. Exporting time depends on how long 
the video is, and how much rendering is required. 

When FCP is done, you should see a .mov file in your Output folder inside your 
project folder.

WATCH your video. Make sure everything is working and the way you want. 
	
 IS there sound?
	
 DOES the video start at the beginning and finish where it is supposed to?
	
 Any editing mistakes, or audio problems that need fixing?

IF you need to change anything, you will need to go back to your Final Cut project, 
make changes, save and re-export.

And now you’re  a filmmaker.

“If you want to tell the untold stories, if you want to give voice to the voiceless, 
you've got to find a language. Which goes for film as well as prose, for documen-
tary as well as autobiography. Use the wrong language, and you're dumb and 
blind.”

 Salman Rushdie
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